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Preface 

Introducing the Relativity DBA 
The Relativity DBA (Database Administrator) is an interactive, Windows-based tool 
that enables the System Administrator at the end user location to maintain and 
manage the Relativity database and the security of the Relativity database. 

The Relativity DBA provides the following functions: 

• Defines and authorizes users of a Relativity database. 

• Restricts the view of the data for individual groups of users. 

• Maintains the linkages, known as table connections, between table definitions 
and physical COBOL data files. 

• Manages date constants. 

• Merges security and table connection information into a new catalog (an 
optional function controlled by the catalog developer). 

• Produces reports on security and connections. 

This manual, the Relativity DBA Installation Guide, which is part of the Relativity 
document set listed in Related Relativity Documentation (on page 2), describes how 
to install the Relativity DBA software component and verify that the installation  
was successful. 

In addition, your Relativity package contains the document, The Theory of Relativity, 
A Primer, which defines specific terminology and provides a comprehensive 
overview of the Relativity software tools and their functions.  Before you install this 
Relativity product, be sure to read this book. 
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Related Relativity Documentation 
In addition to the Relativity DBA Installation Guide and The Theory of Relativity, A 
Primer, the Relativity documentation set consists of the following items: 

• Relativity Client/Server Installation Guide.  A document (one for UNIX and 
one for Windows NT) that is intended for a System Administrator.  It describes 
the following: 

− How to install the Relativity Data Server software component on a 
computer running either a UNIX or Windows NT operating system and 
verify that the installation was successful. 

− How to: 

• Install the Relativity Data Client software component on a secure 
Windows workstation (such as the workstation belonging to a Database 
Administrator) for the purpose of catalog development. 

• Install the Relativity Server Administrator utility program in order 
define a server for the client and configure a server data source. 

• Verify communications between the client and the server. 

− How to install the Relativity Data Client software component on an end 
user’s Windows workstation and verify that the installation was successful 
by configuring a client data source and associating it with a server data 
source. 

− How to run the RM/COBOL Indexed File Recovery utility (recover1) to 
recover an RM/COBOL indexed file. 

• Relativity Data Client for UNIX Installation Guide.  A document that 
describes how to install and verify the Relativity Data Client software 
component on a UNIX-based server or workstation.  It also describes the utilities 
for creating client and server data sources. 

• UNIX Driver Managers Build Guides.  A pair of HTML documents, located in 
the UDrvMan directory on the Relativity Data Server product CD, that give 
instructions on how to build the two ODBC Driver Managers for UNIX 
(unixODBC and iODBC) on the various UNIX platforms that the Relativity 
Data Client for UNIX supports.  Note that these documents should be referenced 
only if you decide to rebuild the Liant-supplied versions of these Driver 
Managers. 

• Relativity Data Manager Installation Guide.  A document that describes how 
to install the Relativity Data Manager software component on a Windows-based 
workstation and verify that the installation was successful. 

• Relativity Designer Installation Guide.  A document that describes how to 
install the Relativity Designer software component and verify that the 
installation was successful. 

• Relativity Java Client User’s Guide.  An HTML document, located on the 
Relativity product CD, that describes the installation and verification of the 
Relativity Java Client as well as information about deploying it with Java 
applications and applets, and setting up data source connections.  The Java 
Client is a Java Database Connectivity (JDBC) component that resides in a Java 
runtime environment (JRE). 
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• Relativity Online Help Documentation.  An online help documentation system 
that provides fast access to detailed information on Relativity features and 
options.  The help system also contains step-by-step presentations on how to 
accomplish specific tasks with Relativity and an extensive glossary.  A separate 
help file is provided for each of the various Relativity tools:  the DBMS (Data 
Client and Data Manager), the Designer, the DBA, and the Server Administrator.  
For more details, see Using Online Help (on page 17). 

• Relativity README Files.  A set of online HTML documents that lists any 
changes to the Relativity documentation since its publication and contains new 
technical information that supplements the documentation. 

Conventions Used in this Document 
This document contains visual cues to help the reader identify important information. 

Table Convention Indicates 

Initial Capitals Menu names, command names, dialog box and 
form titles. 

Bold Menu, command, and button names. 
Other elements to be selected or typed to 
accomplish an action. 
Label on input media used during installation. 

Italic Reference to a topic in the current document or 
another Relativity document. 
Reference to another document. 

Bold Italic Variables. 

Registration 
Please take a moment to fill out and mail (or fax) the registration card you received 
with Relativity.  You can also complete this process by registering your Liant 
product online at:  http://www.liant.com. 

Registering your product entitles you to the following benefits: 

• Customer support.  Free 30-day telephone support, including direct access to 
support personnel and 24-hour message service. 

• Special upgrades.  Free media updates and upgrades within 60 days of 
purchase. 

• Product information.  Notification of upgrades or revisions to Relativity when 
they are released. 

You can also receive up-to-date information about Liant and all its products via our 
website.  Check back often for updated content. 

http://www.liant.com
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Technical Support 
Liant Software Corporation is dedicated to helping you achieve the highest possible 
performance from the Liant family of products.  The technical support staff is 
committed to providing you prompt and professional service when you have 
problems or questions about your Liant products. 

Technical support services are subject to Liant’s prices, terms, and conditions in 
place at the time the service is requested. 

While it is not possible to maintain and support specific releases of all software 
indefinitely, we offer priority support for the most current release of each product.  
For customers who elect not to upgrade to the most current release of the products, 
support is provided on a limited basis, as time and resources allow. 

Support Guidelines 
When you need assistance, you can expedite your call by having the following 
information available for the technical support representative: 

• Company name and contact information. 

• Liant product serial number (found on the media label, registration card,  
or product banner message). 

• Liant product version number. 

• Operating system and version number. 

• Hardware, related equipment, and terminal type. 

• Exact message appearing on screen. 

• Concise explanation of the problem and process involved when the  
problem occurred. 

Test Cases 
You may be asked for an example (test case) of the source that demonstrates  
the problem. 

• The smaller the test case is, the faster we will be able to isolate the cause  
of the problem. 

• Do not send full applications. 

• Reduce the test case to the smallest possible combination of components 
required to reproduce the problem. 

• If you have very large data files, write a small program to read in your current 
data files and to create new data files with as few records as necessary to 
reproduce the problem. 

• Test the test case before sending it to us to ensure that you have included  
all the necessary components to run the test case. 
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When submitting your test case, please include the following items: 

1. README text file that explains the problems.  This file must include 
information regarding the hardware, operating system, and versions of all 
relevant software (including the operating system and all Liant products).  It 
must also include step-by-step instructions to reproduce the behavior. 

2. Program source files.  We require source for any program that is called during 
the course of the test case.  Be sure to include any copy files necessary for 
recompilation. 

3. Data files required by the programs.  These files should be as small as 
possible to reproduce the problem described in the test case. 

 

 

 

 



 

6  •  Relativity DBA Installation Guide  

 

 

 

 

 



 

 Chapter 1:  Installation  •  7 

Chapter 1:  Installation 

This chapter lists the system requirements and describes how to install the Relativity 
DBA software program on a Microsoft Windows operating system.  Procedures for 
removing the Relativity DBA (on page 11), if necessary, are also provided. 

System Requirements 
Installation of the Relativity DBA on a Windows-based workstation for application 
development requires the following minimum software and hardware. 

Component Requirement 

Computer Pentium-class processor or higher. 

Operating System Microsoft Windows 98 or Windows 98 Second Edition (SE), 
Windows Millennium Edition (Me), Windows NT 4.0 or later 
(Service Pack 6 or higher recommended), Windows 2000, 
Windows XP, or Windows Server 2003. 

Memory 64 MB is recommended. 

Disk Space A hard drive with at least 11 MB of free disk space. 

Installation Media Internet access and/or one CD-ROM drive and one 3.5” diskette 
drive. 

Monitor 800x600 resolution is required.  Higher resolution is recommended. 

Internet Browser A browser (for example, Netscape or Microsoft Internet Explorer) 
capable of viewing HTML files, such as the README text or other 
documents that are available in this format. 
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Installing the Relativity DBA 
Note  If you have a version of Relativity that supports the uninstall process, you 
should remove it prior to installing a newer version.  See Removing the Relativity 
DBA (on page 11). 

The Relativity DBA can be installed on a Windows workstation using either of the 
following methods: 

• CD-ROM Installation (on page 8) 

• Electronic Software Delivery Installation (on page 9) 

This installation process also may be automated, as described in Automated 
Installation (on page 10).  To verify the installation is successful, see  
Chapter 2:  Verification (on page 13). 

CD-ROM Installation 
To install the Relativity DBA software from the CD-ROM: 

1. Start Windows. 

2. Insert the product CD in the appropriate CD-ROM drive. 

3. Do one of the following: 

• If the installation program starts automatically, proceed to Step 4. 

• If the installation program does not start automatically, click Start, and  
then click Run.  In the Run dialog box, in Open, type 

d:autorun 

where d is the drive letter of the CD-ROM drive.  Click OK. 

4. If the installation starts automatically or if you start it using the autorun 
command, click DBA Installation and choose from the following list of options: 

• Click the View the README file option to review important last-minute 
information about Relativity. 

• Click the View the Installation Documentation option to read or install the 
documentation for this product that is provided on the CD-ROM. 

• Click the Install the Relativity DBA option to begin the actual installation 
process. 

5. Follow the instructions presented by the installation program. 

6. When the Software License Agreement dialog box opens, you must click Yes in 
order to continue with the installation. 
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7. When the Liant License File dialog box opens, enter the complete filename of 
the license file, liant.lic, which contains the license certificate for this product.  
(This license file is included on the license diskette that came as part of the 
installation media.)  If your machine has a diskette drive, insert the license 
diskette into drive A and continue to follow the instructions presented on  
your screen. 

Note 1  If you are using a drive other than A, be sure to correct the location of 
the license file in the Liant License File dialog box. 

Note 2  If necessary, the liant.lic license file can be copied to a location on a 
hard drive and that location can be specified during installation. 

8. When the Choose Destination Location dialog box opens, note that the 
Destination Folder box indicates the location on your hard drive where 
Relativity will be installed. 

9. When the Select Program Folder dialog box opens, specify the program folder 
name that will appear on the Windows Start menu. 

10. When the Setup Complete dialog box opens, select the check box to register 
your product online or click Finish to close the dialog box. 

Electronic Software Delivery Installation 
Note  You must have an Internet connection and an Internet browser installed to 
proceed with this method of installation. 

The Relativity DBA is available as a download from the Liant Electronic Software 
Delivery website in two formats:  ISO CD Image and Windows Self-Extracting EXE.  
Simply follow the instructions on the website for downloading and decompressing 
the file for the format selected. 

• ISO CD Image.  The download format for ISO CD Image contains the full 
product.  Use CD-ROM Burning software, such as Nero (http://www.nero.com) 
or Roxio’s Easy CD Creator (http://www.roxio.com), to create the physical  
CD-ROM media and then follow the instructions contained in the CD-ROM 
installation (on page 8) section to install your product. 

• Windows Self-Extracting EXE.  The download format for Windows  
Self-Extracting EXE does not contain a full product.  In order to reduce the size 
of the download file, the AutoPlay and Adobe Reader software, normally 
available on the CD, are not present.  Furthermore, the Relativity installation 
guides are included in the deliverable download file but not the installation script 
to install these guides.  The installation guides, formatted as PDF files, can be 
installed simply by copying them to the desired location. 

After the deliverable has been downloaded and uncompressed, and the 
installation components have been created from the Windows Self-Extracting 
EXE format, follow the instructions below to install the Relativity DBA 
software: 

1. Start Windows. 

2. Click Start, and then click Run.  In the Run dialog box, click the  
Browse button. 

3. In the Browse dialog box, navigate to the directory containing the 
installation components and open the DBA directory. 

4. Click on the file, Setup, and then click Open. 

http://www.roxio.com/
http://www.nero.com
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5. In the Run dialog box, click OK. 

6. Follow the instructions presented on the installation dialog boxes. 

7. When the Software License Agreement dialog box opens, you must click 
Yes in order to continue with the installation. 

8. When the Liant License File dialog box opens, enter the complete filename 
of the license file, liant.lic, which contains the license certificate for this 
product.  (The license file was attached to the original electronic software 
delivery e-mail.) 

9. When the Choose Destination Location dialog box opens, note that the 
Destination Folder box indicates the location on your hard drive where 
Relativity will be installed. 

10. When the Select Program Folder dialog box opens, specify the program 
folder name that will appear on the Windows Start menu. 

11. When the Setup Complete dialog box opens, select the check box to register 
your product online or click Finish to close the dialog box. 

Automated Installation 
You can also automate the installation program for the Relativity DBA, which allows 
the installation of the DBA to be incorporated with the installation of your product.  
To automate the installation, use a set of options that predefine answers to the 
installation prompts.  The predefined answers are supplied on the command line to 
the setup command.  You can also configure the installation procedures not to 
prompt for questions at all. 

The following set of command line options can be used to change the initial default 
values for the installation prompts presented to the user.  Note that the -_AUTO 
option is used to prevent any prompting by the Relativity DBA installation program.  
In order for the calling installation program to wait for the DBA installation program, 
you must add the -SMS option as the very last option on the command line.  This 
option allows the calling installation program to determine when the Relativity DBA 
installation program completes. 

Note  Option values that contain spaces must be enclosed in quotes (“ ”) or square 
brackets ([ ]). 

• -_AUTO=Y.  This option specifies automatic installation without prompting.  
The default is to prompt the user during installation. 

• -_FOLDER=folder.  This option specifies folder as the folder for icons.  The 
default is Relativity. 

• -_LICENSE=license file.  This option specifies that license file is the location 
of the license file.  The default is A:\liant.lic. 

Note  If necessary, the liant.lic license file can be copied to a location on a hard 
drive and that location can be specified during installation. 

• -_ORG=organization.  This option specifies organization as the name of the 
user’s organization.  The default is blank. 

• -SMS.  This option, which allows the calling installation program to determine 
when the Relativity DBA installation program completes, must be entered as the 
last option on the command line. 
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• -_TARGETDIR=directory.  This option specifies directory as the installation 
directory.  The default is C:\Program Files\Relativity. 

• -_USERNAME=user name.  This option specifies user name as the name of the 
user installing the DBA.  The default is blank. 

Note  The default values for most of these options are generally sufficient.  However, 
the -_LICENSE option is particularly useful in order to specify another location for 
the license file other than the diskette drive. 

Removing the Relativity DBA 
The Relativity DBA can be removed from the Windows workstation on which it was 
installed.  This may be necessary if the Relativity DBA is to be moved to a different 
machine or if a new release of the Relativity DBA is to be installed on the same 
machine. 

Removing an existing version of the Relativity DBA prior to installing a new one 
ensures accurate use counts on shared files and enables all files to be properly 
removed during a later uninstall process. 

To remove the Relativity DBA: 

1. Click the Start button, point to Settings, and then click Control Panel. 

2. Double-click Add/Remove Programs. 

3. In the Add/Remove Programs Properties dialog box, click the Install/Uninstall 
tab. 

4. In the list box, select Relativity vX DBA where X indicates the version number. 

5. Click the Add/Remove button to proceed with the uninstall. 

6. In the Confirm File Deletion message box, click Yes to proceed with  
the uninstall. 

 

The Remove Programs From Your Computer dialog box is then displayed, 
detailing the progress of the uninstall.  When the uninstall is successfully 
completed, click OK. 

7. Click OK to close the Add/Remove Programs Properties dialog box. 

8. Close the Windows Control Panel. 
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Chapter 2:  Verification 

This chapter describes how to verify the installation of the Relativity DBA software 
on a Windows-based workstation.  The verification takes place with a catalog that 
was installed during the installation of the Relativity Data Manager or Relativity 
Data Server, and a data source named Verify that was created during the verification 
of the installation of the Relativity Data Manager or Relativity Data Server and Data 
Client products. 

Methodology 
The Relativity DBA is used by the System Administrator to maintain the linkages 
between table definitions and physical COBOL files. 

If the Relativity DBA has been properly installed, you will be able to view the 
existing table connection for the BackOrder table in the sample Verify database. 

Relativity must know the physical access name information for the COBOL file that 
contains the actual data.  The table connection consists of two important items: 

• The path name (that is, the physical filename) of a COBOL data file. 

• The table name by which SQL statements can reference the data in the file. 

Relativity distinguishes between the name of a table definition and the actual SQL 
table name.  Physical files that share the same COBOL file definition may be 
described by one Relativity table definition.  The table name within the table 
connection is what an ODBC-enabled application actually “perceives” as a  
relational table. 

Prerequisites 
This verification process assumes the following: 

• If you are using the client/server version of Relativity, that you have followed 
the instructions in the Relativity Client/Server Installation Guide (for either 
UNIX or Windows, as appropriate) to install a Relativity Data Server, set up a 
server data source named Verify, install a Relativity Data Client on the same 
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machine as the Relativity DBA, and set up a client data source that is also named 
Verify and associate it with the server data source, Verify. 

• If you are using the single-tier (that is, non-client/server) version of Relativity, 
that you have installed a Relativity Data Manager on the same machine as the 
Relativity DBA and followed the instructions in the Relativity Data Manager 
Installation Guide for setting up a data source named Verify. 

Starting the Relativity DBA 
To start the Relativity DBA in Windows: 

1. Click Start, point to Programs, point to Relativity, and then click DBA. 

The Welcome to Relativity window is displayed and you are ready to open the 
Verify data source. 

 

Note  The Welcome to Relativity window appears when you first install and 
start the Relativity DBA.  From this window, you can set up and create a new 
data source, or open an existing or recently used Relativity data source.  After 
completing the first session with Relativity, the most recently used data source is 
always selected by default in this window when you start Relativity again.  To 
disable the Welcome to Relativity window after the initial installation, clear the 
Show Welcome at Startup check box.  Subsequently, when you start another 
Relativity session, you will begin all operations in the Relativity DBA main 
window.  You may, however, enable this capability again by choosing Welcome 
from the Tools menu. 

2. If you wish, click Cancel to dismiss the Welcome to Relativity window. 
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Opening a Data Source 
To open the Verify data source: 

1. In the Relativity DBA main window, on the File menu, click Open Data 
Source. 

The Open Relativity Data Source dialog box opens. 

 

Alternatively, if the Welcome to Relativity window remains displayed, click the 
Open existing data source option, select the Verify data source from the list, 
and click OK.  Proceed to Step 3. 

2. In the Data Source Name box, select Verify.  If necessary, click the Down 
Arrow to display a list of data source names. 

3. Click Open. 

The Logon dialog box opens to collect information needed in order to 
authenticate your access to the server. 

 

4. In the Logon dialog box, type a user name in the appropriate box and click OK.  
(Because security has not been set up to access the Verify data source, any user 
name will suffice and no password is required.) 

The Catalog window for the selected data source, Verify, is displayed in the 
Relativity DBA main window. 
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Viewing a Table Connection 
1. In the Relativity DBA main window, on the Edit menu, click Connections. 

The Edit Connections form is displayed. 

 

Alternatively, select the table name on the Tables tab in the Catalog window and 
click the Connections button.  When you use this method, the table definition is 
already expanded to display the table connection in the Edit Connections form, 
as described in Step 2. 

2. In the Edit Connections form, expand the table definition and display the table 
connection associated with the table definition: 

a. Click the plus sign [+] preceding the table definition to display the table 
name, BackOrder. 

b. Click the plus sign preceding the table name to display the path name, 
PROD2FIL. 

 

The Edit Connections form shows the existing table connection (that is, the table 
name and the path name) for the BackOrder table, which indicates that the Relativity 
DBA has been installed correctly. 
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Using Online Help 
The Relativity DBA Help file is the fundamental online reference for the Relativity 
DBA.  It is designed to help you learn and use the product. 

You can access the Relativity DBA Help file in several ways: 

• In the Relativity DBA main window, from the Help menu, click Contents to 
display a list of Help topics.  You can use the tabs in the Help Topics dialog box 
to search for information: 

− To browse through topics grouped by subject:  Click the Contents tab.  
From here, you can go directly to information that is more specific and to a 
list of all the Help topics by double-clicking any closed book icon.  Then 
select the topic of interest from the expanded list and click the Display 
button.  (Alternately, you can double-click the topic.)  The Help window for 
that topic appears. 

− To see a list of alphabetized index entries (or keywords):  Click the Index 
tab.  The online index is arranged just like a book index.  Click the Index tab 
to find specific topics listed alphabetically.  Type an entry or the first few 
letters of the word you want to search for, or scroll through the list.  Then 
select the topic and click the Display button. 

− To search for words or phrases that may be contained in a Help topic:  Click 
the Find tab.  Follow the instructions on your screen to complete this task. 

• In the Relativity DBA main window, from the Help menu, click Search for 
Help On to display the Index tab of the Help Topics dialog box.  Here you can 
search for topics that contain a specific term or phrase. 

• While you are working in Relativity, you also can press F1 to access the Help 
topic for the specific task at hand or currently selected item in the window or 
dialog box.  (This is called context-sensitive Help.) 

• If available, click a Help button in a dialog box.  A Help topic window is 
displayed. 

From the Help menu, you can also access additional online Help files: 

• Click DBMS Help File for information on using the Relativity Data Manager. 

• Click Server Admin Help File for information on using the Relativity  
Server Administrator. 

 

 

 

 

 

 

 

 

 



 

18  •  Relativity DBA Installation Guide  

Closing the Data Source 
To close a data source, do one of the following: 

• On the File menu, click Close Data Source.  Shortcut:  Ctrl+D. 

• In the Catalog window, click Close in the upper-right corner of the title bar. 

When you close a data source, the Relativity DBA main window remains open, 
allowing you to reopen the data source, open another data source, or exit the 
Relativity DBA. 

Exiting the Relativity DBA 
To exit the Relativity DBA, do one of the following: 

• On the File menu, click Exit.  Shortcut:  Ctrl+F4. 

• In the Relativity DBA main window, click Close in the upper-right corner of the 
title bar. 
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